Solar Action Webinar Series:

Innovation and Solar Permitting and Inspections
June 26,2013
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Why We’re Here: The Big Picture

SunShot Initiative

~6¢/kWh without subsidy

Price

75% cost redu the end of the decade
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Panel Prices Plummeted
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However...

“Even if you paid nothing for the hardware, you'd still pay
thousands of dollars to install a residential solar power
system.”

- Former Secretary Chu
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What is SunShot Targeting?

Soft Costs

Customer
Acquisition

Financing Permitting Installation Maintenance

Up to 50% of the

cost of a solar
installation
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A Fragmented Marketplace
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The Problem:
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= 8,000+ local jurisdictions with

authority over PV permitting
requirements, land use codes and

zoning ordinances

= 5,000+ utilities implementing |
interconnection standards and net
metering programs

= 50 states developing interconnection
standards and net metering rules
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" LaMirada, CA Oceanside, CA
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ROOFTOP SOLAR CHALLENGE 4 o= B

Southeast
12,500,000 Peopl
Northeast
10,200,000 People

Midwest
5,000,000 People

Southwest
20,500,000 People

Northwest
790,000 People
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Rooftop Solar Challenge Successes

Permitting
* 40% Faster
* 2% Cheaper

Overall Time Saved: Om
" Per

Install
™ '
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Does One Week of Time Mean?
alled in RSC locales:

Residential: 225 MW Commercial: 357 MW

37,960 Residential
Systems

3,148 Commercial
Systems

Average Business Days

Average Business Days

Saved Per Install = 5.1 Saved Per Install = 4.1

Which means the RSC saved
Americans from an
estimated...

792 YEARS OF RED TAPE
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Growing Solar Friendly Communities
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~ Public-Private Partnership:
~ Cities, Counties, Nonprofits, & Industry

An innovative partnership launched to address
‘soft costs’ in 2012 as part of DOE SunShot’s
Rooftop Solar Challenge

Goal: to make it easier, faster and more
affordable for citizens to go solar

Involves cities, counties, industry, non-profits
Focused on best practices & education

Helps local governments prepare for the rapid
increase in citizens who want to go solar

Recognition for local governments who take steps

www.solarcommunities.org



Solar Friendly Communities Offers
Benefits to Local Governments

An easy-to-follow roadmap of Best Practices
Individual outreach, education, coaching
A menu of options giving choice to local communities

Recognition as a Solar Friendly Community with a relatively

low entry bar. Includes road sign, plaque, media attention,
public ceremony

Eligibility for residents to get $500 discounts




Denver and Aurora Recognition:
First of 8 Communities So Far
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Four Levels of Recognition for Adopting Best Practices

Earn enough points to win designation as a Solar Friendly Community

Designation Points Required

Bronze 700
Silver 900
Gold 1100

Platinum 1400

The program is flexible and allows participation by both large
and small jurisdictions

www.solarcommunities.org



12 Best Practices: A Roadmap to
a Solar Friendly Community

Take a trip on the rcadmap! Click on each wedge to learn more.
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1. Provide a checklist of all permitting requirements in a single
location (275 Points)

Reasoning

Hosting up to date solar requirements in a single online location is one
of the simplest, easiest ways to make sure installers and customers
submit the right information on the right forms the first time. This will
save everyone involved in the process time and money.

Example

The cities of Philadelphia of Denver offer simple and easy to use
permitting checklists that represent different approaches to this best
practice.

How to make it happen

Check out the permitting checklists online. Then, see where your
current solar-related documentation is hosted and map out the
different web pages, if applicable. Talk to your community’s
webmaster about consolidating the information.

www.solarcommunities.org



2. Offer a standard permit form that is eligible for streamlined
review (275 Points)

Reasoning

Permitting processes can add time and money to the installation of
solar PV. By standardizing solar permitting, jurisdictions can
streamline and expedite the process.

Example

Solar ABC’s Expedited Permit Process for PV
Systems provides a national standard of
procedures developed by industry experts.

How to make it happen

Check out Solar ABCs on the SFC website and see how it compares
to your existing permitting process. If not possible, designate one
primary point of contact for installers for standard permits.

www.solarcommunities.org



3. Offer electronic or over-the-counter submittal and review
options for standard systems (150 points)

Reasoning

Electronic or over-the-counter submittal procedures can significantly
cut down the time necessary for approval of permits, freeing up time
for departments and installers.

Example

Santa Clara offers over the counter permitting, enabling

installers to walk in with an appllcatlon and walk out with

approval in one visit. ; S

& O;SANTA CLARA i

A,

How to make it happen

Initially, designate a point of contact who is well versed
in PV permitting that will be able to turn around
approvals or denials in a timely fashion. At the very least,
authorize plan checkers to electronically communicate

with contractors if an issue comes up.



4. Issue permits within a specified timeframe (100 points)

Reasoning

If a jurisdiction establishes and states a timeframe for
permitting application decisions, installers have a better
opportunity to plan their projects. This frees up time and
enables installers to clearly communicate project timelines
with customers.

Example

For a project that meets established criteria, the City of Philadelphia
will issue an over-the-counter permit. In special cases, a standard
permit will be issued with a 20-day approval timeline.

How to make it happen

Strive to issue permits the same day or within three days of
application submittal. If this is not possible, state a firm policy on
how long permits will take on your jurisdiction’s permitting
website.

www.solarcommunities.org



5. Charge actual costs for permits and inspections with a cap on
the total (200 Points)

Reasoning

Fees and costs associated with permitting and inspecting solar PV can
create significant barriers to adoption. In some cases, these costs do not
reflect the actual time and work associated with the process. By capping
the fees and/or charging actual costs, the economics of solar improve.

Example

In Sacramento, California, installers pay a graduated
flat fee for all commercial and residential systems. SACRAMENTO

In the year since the city started cutting solar fees, STREAMLINE
permits more than doubled.

How to make it happen

Understand the specifics of your jurisdiction’s cost methodology for setting
permitting and inspection fees. Some jurisdictions create exemptions for
systems that meet standard engineering calculations.

www.solarcommunities.org



6. Replace community-specific solar licenses, if required, with
standard certification for installers (25 Points)

Reasoning

Community- specific solar licenses can add unnecessary bottlenecks.
Replacing them with nationally accredited standards is simpler and helps
establish a national standard of competency for the solar industry.

EHICAN
Example *w °°
§ K
The North American Board of Certified Energy cEnTIHEn %
Practitioners has established a national standard for solar: V %
installations. ) ‘ Sﬂlal‘ P“ ;,_-_t
', Installer §
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How to make it happen LUioyya M

Learn about NABCEP certification by exploring the website. Consider
allowing NABCEP certified installers to bypass unique certification and
inspection requirements within your jurisdiction.

www.solarcommunities.org



7. Provide inspection checklist that explains unique
requirements beyond applicable codes (50 Points)

Reasoning

Some jurisdictions have unique priorities or interests that are not necessarily

clarified by referring to adopted electric or building codes. Specifying these

exceptional requirements upfront can help the jurisdiction avoid repeat
inspections and allow installers to pass inspections more often.

Example

Boulder County’s checklist for PV systems
clearly states its requirements for rough
inspections.

How to make it happen

Boulder
County

S

Solar

il |
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|

Photovoltaic

Systems
Checklist

Work with your building department to see if local inspection staff have

any “unique” requirements or interpretations of existing code. Reach out to

local installers for feedback to understand any confusion that exists and
publish a checklist on the jurisdiction’s website.

www.solarcommunities.org



8. Specify a narrow time window for system inspection
(75 Points)

Reasoning

Many communities have unpredictable timelines for when an inspector will
come to a job site. That makes it hard for solar installers to plan their projects.
By narrowing the window for a system inspection, installers can spend less
time waiting on job sites—and that directly translates to cost savings.

KON
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DENVER

THE MILE HIGH CITY

Example

Denver has a two-hour inspection window,
making the city one of the most efficient and
timely for PV projects.

How to make it happen

Start the conversation with the building department and assess the current
inspection window. Reach out to local solar contractors to see what'’s
working well and what can be improved upon.

www.solarcommunities.org



9. For efficiency, require only one inspection for standard
rooftop systems on existing homes and businesses (100 points)

Reasoning

Multiple inspections add time to PV installations, requiring additional visits
and hours on the the job site. Requiring a single inspection—rough or
comprehensive—can significantly cut this time.

Example _ GUIDEBOOK FOR
. . . . SOLAR
The City of Philadelphia requires a | T PHOTOVOLTAIC
single field inspection for ° CITIESF) PROJECTS
. . . IN PHILADELPHIA
residential projects. | ﬁﬁ orfEnwcs
mmphh T a5 otk

How to make it happen

If your jurisdiction requires multiple inspections for a PV installation,
reassess existing requirements and compare your jurisdiction to analogous
communities with fewer requirements. Work with chief engineer and
building officials to discuss feasibility of a single inspection.

www.solarcommunities.org



10. Adopt ordinances that encourage distributed solar
generation and protect solar rights and access including
reasonable roof setback requirements (150 points)

Reasoning

Various policies can create a more favorable environment for solar PV. By
implementing policies that allow installations and ensure access to solar
access, fewer conflicts will emerge in the future.

Example

Fort Collins Colorado has developed an integrated approach to
sustainability and solar programs .

How to make it happen

Work with the local sustainability office, historic preservation advocates,
fire officials, and your urban forester to assess the feasibility of adopting
policies that explicitly balance potentially competing community desires
such as urban forestry, historic preservation and solar access.

www.solarcommunities.org



11. Educate residents on solar energy by providing information
on financing options and projected economic benefits
(125 points)

Reasoning

Improving education and consumer awareness remains critical to the success
of solar adoption. Many potential customers lack adequate information on the
options available.

Example

The City of Santa Monica houses a best-in-class customer
education website for interested residents. They also
provide educational materials on financing options.

How to make it happen

Develop tools and resources for website to educate consumers on value of
solar and options available. Also consider outreach events.

www.solarcommunities.org



12. Track community solar development and provide tools
showing solar access in your community (75 points)

Reasoning

Keeping tabs on solar installations helps communities track progress toward
becoming a Solar Friendly Community, but it can also be used as an
educational tool, showing momentum and potential to customers.

Interactive map of commercial solar installations
="

Example

Arizona has a state-wide program to track
applications for solar installations.

How to make it happen ;- SOLAROne Stop

<
V‘\rw‘.‘é n to a solar energy future

Work with your permitting office and utility to quantify solar installations
and publicize them through communications channels, such as your
website.

www.solarcommunities.org



| What’s Next?

« Working on refinements to scale program
nationally

« Expanding Solar Friendly Communities Discount
Program

« Adjusting to make program applicable to wide
variety of communities including small ones

« Discussing ways to align with similar efforts

www.solarcommunities.org
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Broward County and Partners
Go SOLAR
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Partnership Emphasis

BRICVWARD

- COUNTY
[F L O R I D A

-

== Broward County
Publie Sehools
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What is Go SOLAR?

= Partnership between Broward County, Florida
and 14 of its 3 I municipalities

" Create a fully electronic permitting system for
rooftop solar photovoltaic installations

eeeeeeeee
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Go SOLAR Solution

| Year to Implement
VVEB site used by all partners
Access to selection of pre-approved design plans

o Designed for majority of roof types in South
Florida

A single permit fee

Immediate issuance of electronic permit

Coordination of inspections with municipalities

eeeeeeeee
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Go SOLAR Solution

Solar
Contractor

Go to City
to Pay Fee
and Obtain

Permit

Engineer
Designs
System

Review ~ Apply in
Comments/ severa Person at
Responses City for
Process Permit

Zoning Building
Department Department
Review Review
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Solar
Contractor

Apply &
Obtain
Permit
Online

Proposed Process
A Few Minutes
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__4Broward Rooftop Solar Challenge

Go SOLAR Application

Online Permitting System

GoSOLAR Home

» GoSolar Home

+ Sign Out

+ Search for
Permit

» My Permits

b Permit List

» Apply for New
Permit

F Request Next
Inspection

» My Account

» Update
Infermation

¥ Change
Password

Shot

U.S. Department of Energy

Search for Permit Help Contact Us

Apply for a New Permit

Terms of Use > Property > Owner > Project > Roof > System = Review = Pay

Property Information

Below, please describe the property for which you are requesting a permit, then click the button
to go to the next step. Items with an asterisk (*) are required.

Please use the Property Appraiser Web site to look up or confirm information about the property.

If the permitting autharity for the property is not listed here, you cannot use this system to apply
for this permit and must contact the appropriate agency directly.

Jurisdiction: * |<—— Mot Selected —=» W

Street Address: *

Address Line 2:

|
|

City/State/ZIP: * | || FL |w || |
|

County: *

Legal Description: * | |

Broward |

Building Use: * . . .
9 O Low Caommercial O Residential

[ Save and go to Next Step ]

Broward Home | Terms of Use

35



Go SOLAR Application

Welcome, TestCustomer  Sign Ouot

—

Online Perﬁn‘tﬁng System

ter Help = Contact Us

GoSOLAR Home Search for Permit

Apply for a New Permit

Terms of Use >Property =Owner >Project *Roof> System = Review > Pay

» GoSolarHome

k Sign Out
» Search for
Permit Roof Structure Type
¢ My Permits
» Permit List Please choose onz option below to indicate the type of roof structure an which the selar panels will
be installed, Ifthe appropriate roof structure typeis notlisted, please contactthe apprepriate

b Apply for New agency directly and de notuse this system to apply for the permic

Permit
) Flat - other than tile

O Cancrets

b Reguest Next O parrel Tile

Inspection
¢ My Account

» Update
Infarmation

¥ Change
Password

OME‘tE' OShingIE

[ Save and go to MNext Step ]

Powered by Broward Home | Terms of Use
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Go SOLAR Application
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GoSILAR Homa Egarch for Parmit

v DoEplar Homse

b Sign Dt

b S2arch Tor
Parmilt

b My Parmits

Hailp ContactUs

Payment Confirmation

Thank wou for your payment. A oonfirmathon amall has besn &0t o the =ma
adiregs TRt wou Spaciled.

The parmit describad balovw has now been Esusd,

Ph=nte print this messsge far wour necands.

Paryrme=nt Deybes: 100172012 2:55 PM

Paryime=nt iDomfinmaatian Numiber [EE i

Paryimeent Sumount: S552.04

Parmit Issued

Jurisdlotian Unincorporated Browand Couwnty
Penmilt Mumibesr 12-D0: 01T

Penmit Halder hame= Tast Customar

Do Tk 2701 Proparty

What now?

¥ vou maary o whew and pring wour permit JooumesTtE:

E'T it Card E:ccm:.:a: System De=cign
E'T It SICUM=NT m.:':a De=clign

mﬂ':ﬂ:l Ehourting Systam Decign
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How We Did It
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Standardized
Permitting

IT
Development

Steering
Committee

Planning and
Zoning
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How We Did It

www.broward.org/gogreen/gosolar

Microsoft Translator | Google Translate

BRIGWARD.org

Our Best. Nothing Less.

Green Government = Municipalities Business Residents = Green Learning GoSOLAR

Broward County > Go Green > GoSOLAR & Printer Friendly

» Broward's Welcome to Go SOLAR Broward Rooftop Solar Challenge
Sustainability
Leadership

» Contact Us

+ Educational
Resources

» Financing Options
» FPL Applications
and Rebates

» Frequently Asked
Questions (FAQs)

»Go SOLAR
Committees

» Go SOLAR Events
» Participating Cities
» Partner Resources

You're just a dick away from your solar permit,
the Go SOLAR Online Permitting System is Now Live!

» Solar Customer

Assistance oty
» Solar Rights In Imagine a process that currently takes weeks to accomplish that is now L SunShot
Florida reduced to a few clicks of your mouse button. Imagine also that the U.S. Department of Energy

system that you're utilizing is unique to Broward County and the entire
EStatusliipdates county. The Go SOLAR Online Permitting System is a unique

» Training accomplishment made possible by the Go SOLAR Broward Rooftop Solar E&E
Challenge. This is a U.S. Department of Energy grant-funded program that

makes it easier for Broward County residents and businesses to convert to Go b‘; &
solar energy by reducing the cost and wait time associated with the h'.. %
permitting process for installing photovoltaic (PV) rooftop solar systems. GREE L '

Online Permitting

Go SOLAR Fest Was a Shining Success. Now Online!

AL A Zm— -
Powered by GO SOLAR . =

Shot

U.S. Department of Energy

Resources

Broward Solar
Rooftop Challenge




Permitting Improvements

Pre-Go SOLAR Go SOLAR

Cost for Developing
Plans $2,000 SO

Average Permitting Fee S630 S552

Prepare and Route

Permit $200 SO
$2,830 $552
80% Reduction
Time to Issue Permit 5.7 — 1.5 Days 1 hour

eeeeeeeee 92% Reduction

eeeeeeeeeeeeeeeeeeeeee
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Rooftop Solar Challenge 1l Goals

* To build strong regional solar markets by rapidly
deploying innovative, transformative, locally-generated
solutions on a broad scale;

* To enable solar companies to more efficiently manage
their labor, material and cash flows, and customer
interactions by introducing process predictability and
standardization at the local government level; and

* To increase affordability of residential and small-scale
solar PV.

Shot

U.S. Department of Energy
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Rooftop Solar Challenge 1l Goals

= Additional Potential Partners

* Alachua County
* Orange County

¢ Miami-Dade

e Sarasota County

* Monroe County

* St. Lucie County

eeeeeeeee

eeeeeeeeeeeeeeeeeeeeee
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Lessons Learned

= Communication

= Collaboration vs. time

= Keeping partners engaged
"= Time
* Going Rogue
= New technology time sinks
" Variety vs. Efficiency
" Free is good
* Training
" Value of a good idea

= Show me the money
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